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1 Description of RelAir R2ZM Gateways

The RelAir R2M allows you to integrate up to 63 Wireless M-Bus meters into your existing M-
Bus installation. For this purpose the OMS-compliant gateway stores the meter data and
answers a request by the M-Bus Master with the last answer telegram. The Gateway receives
devices with wireless M-Bus interfaces compliant with EN13757-4 at 868 MHz in S1, T1 or C1
mode and is OMS compliant. The RelAir R2M decodes unencrypted or AES encrypted
telegrams according to Mode 5 or 7.

M-Bus Communication
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Picture: Wireless M-Bus system with PadPuls M2W, RelAir R2M Gateway and PW250

Because of the configurable whitelist it is of course possible to run several RelAir R2M in one
M-Bus network. Due to the integrated mini USB interface the RelAir R2M can also be used as a
full operational Wireless M-Bus Master, which e.g. in combination with MBSheet enables a read
out. The gateway works without an external power supply and is either supplied from the M-Bus
(5 standard loads) or via the USB interface.

Attention: Never connect a M-Bus Master and a USB cable at the same time!

A configuration of the whitelist and the receive mode (C1, S1, T1) is absolutely necessary.

With the free PC software RelAirConf the setting of the parameters, the keys and the whitelists
is very comfortable.

You can get this software here:

- On our homepage www.relay.de
- Onthe CD ,Tools&Docs* enclosed with the product

User Manual RelAirConf- 06/2018 - VERSION 1.1 3


http://www.relay.de/

Rela i

2 Installation

The RelAirConf software for parameterizing the Wireless M-Bus to M-Bus Gateways RelAir
R2M is a 32-bit application that can be executed on an IBM-PC compatible computer under the
operating systems Windows 10/8.1/7.

If you want to perform the configuration via the USB interface, please first install the FTDI driver
for the virtual comport of the RelAir R2M from our homepage www.relay.de, the CD "Tools &
Docs" or from the site of the chip manufacturer: http://www.ftdichip.com/Drivers/VCP.htm.
Subsequent connect the USB cable to a free USB port on the PC. Now a new virtual serial port
should be created in your control panel. Please choose this new serial port later in the
RelAirConf software.

If you want to configure the gateway (s) in an M-Bus system, you need transparent access to
the M-Bus via a serial interface of the used M-Bus level converter. The serial interface can be a
real RS232C or even a virtual serial comport e.g. a USB or Ethernet interface.

Please start the file "RelAirConf-x.y.z.exe" from Windows Explorer or via "Start - Run" to install
the software. Please note that the file must not be started from a network drive. In the file name
are the placeholders x.y.z for the corresponding version number, e.g. 1.1.1. The language of the
installer is automatically selected based on the language of your operating system. During
installation, you will be asked to accept the license terms. On the desktop, a link to the program
"RelAirConf" and the uninstall program "Uninstall RelAirConf" will be created. Please first
execute the uninstall program before installing a new version if there is already an older version.

2

Setup - RelAirConf 1.1.2

Relay.::s

>l

Welcome to the RelairConf 1. 1. 2 Setup Wizard.

Mext = Quit
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3 Operation

The program is started by double-clicking on the icon shown on the right.

RelAirConf
3.1 Fast pass manual configuration
When you first start you'll see the user interface with a new, empty project:
E:e- Conf 3 - New Project |E”EHE|
File Language &  Help
Channels
Create a new channel from the "File" menu
Exit

A project is a logical group (= property or site) of channels to which one or more gateways are
assigned. A channel may include a gateway (e.g., via the USB interface) or multiple gateways
connected via the M-Bus interface of an M-Bus level converter. A channel always includes a
serial or virtual serial interface of the used PC. All settings and meters are saved in the
associated project file. When restarting the program, the last active project is automatically
opened.
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In the first step you create a new channel: 2 RelAirConf 1.1.2 - New Project
Menu ,File — New Channel o
or use the keyboard shortcut ,Ctrl+N* File  Llanguage & Help

MNew Channel Ctrl+M

[

Please enter a name and a description

for this channel in the following dialog: New Project
Open Project Ctrl+0
New Channel
Save Project Ctrl+s
Comport 1 Save Project As

M-Bus Level Converter PW250 an COM1]|
Open Key File

Cancel Accept Exit Ctrl+Q

With the button "Accept” the channel is created and displayed on the program interface. You
can also create additional channels here, as the following figure shows.

E?E—'::*:"L-‘E Project |':'||E|||53|

File  Language i# Help

Channels
Comport 2 Comport 1
M-Bus Level Converter PW60 an COMZ2 M-Bus Lewvel Converter PW250 an COMI
0 Gateways, 0 Meters 0 Gateways, 0 Meters
Delete Open Delete Open
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Now open the new channel and select the appropriate comport. In this case, this is the PC
internal, serial PCI port COM1. The virtual ports of the RelAir R2M gateways, which may be
connected via USB, appear in the list as COMx (USB Serial Port). But beware: That could also
be virtual ports of other manufacturers. If you have reconnected a gateway via USB, you can
refresh the list with the "Update" button. A manual input of the serial port is alternatively
possible if it should be missing in the list. To do this, move the slider from "Auto" to "Manual”.

K= RelairConf 1.1.2 - New Project - O x

File Language ¥  Help

Select A Serial Port

Auto Manual Refresh

Device | COM1 (PCI Serial Port (COML)) c | ?
Baud COM1 (PCI Serial Port (COM1)) ?

COM2 (PCI Serial Port (COMZ2))

COM#4 (Lantronix CPR Port (COM4))

Back Mext

Now we recommended to save the project with the created channels first: Menu "File - Save
Project" and specify the folder together with the file name. Then click on the button "Next" and
come to the actual main window "Configuration and Diagnosis”, in which all settings of the
gateways of this channel can be done.

Please start the search for the RelAir R2ZM devices with the button "Find Gateways". Depending
on the number of gateways and the number and address distribution of real M-Bus meters, it
may take a while (15 minutes and more are possible) to find all the devices. In the following
example 3 gateways have been found:
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E:e- Zonf 3 - Demo_Projekt_Relfir.pro ||:|||EI||§3‘
File  Language & Help
Configuration And Diagnostics
Search X Filter
Device Man. Ver. RSSI Age RSL WL Key Data
» 10000001 BEL % Status Commands
» 20000002 REL 96
30000001 REL 96
88776601 REL B0 -42 1] s x
78567702 REL 80 -50 (1] ' b4 Name 30000001 7
80006229 KAM 53 -62 0 s X X
B8776602 REL B0 -44 1] s x
00000301 REL B0 -37 1] s x Pri. Addr. ?
00000302 REL B0 -38 1] s x
78567701 REL B0 -45 1] s x
00000401 REL 80 -29 0 v x x 0
65011650 1 19 =0 o P x x Sec. Addr. 36 60 48 AC 30 00 0001 7
60136697 ESY 16 -4 0 v x x
00000402 REL 80 -29 0 v ® R
00080701 REL 20 36 0 p x 30000001, REL, 96, Radio converter (system side) ?
17000284 mw 51 -63 0 s * *
05080702 REL B0 -37 1] s x )
61596629 DME 65 66 0 s X X Firm. vers. 132 ?
00030695 SEN 124 -60 1] s x
00053928 SEN 11 -64 1] s x x ™
Mode T C|(
Discard Apply
Find Gateways Refresh Gateways | Auto Configuration Abort All
Back

Please repeat the search again if not all devices were found during the search. The Radio Scan
List (RSL = the list of receivable wireless M-Bus meters) of each gateway is automatically read
after the search. By clicking on the arrow in front of the ID of a gateway, the view of the
respective RSL can be opened or closed.

The settings of the receiver marked in the left area can be seen in the right area of the tabs
"General", "Status" and "Commands". Please first set the reception mode for the Wireless
M-Bus via the "Mode" selection box according to the transmitters in the system. There are
modes S, T and C to choose from. If you have changed a field and have not yet transferred it to
the RelAir R2M, this field will be highlighted in yellow. With the button "Apply" the changes are
transferred to the gateway. Please first set the correct mode for all receivers.

If you click the question mark after one of the fields, you will see a detailed explanation of that
field. After setting the mode, the RelAir R2M waits for telegrams from radio transmitters. At this
point you should delete the lists of the received transmitters (= Radio Scan List RSL) of the
RelAir R2M. Under certain circumstances, these could be meters that sent with the previously
selected mode. Deleting the RSL can be done by three different ways:

User Manual RelAirConf- 06/2018 - VERSION 1.1 8
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1. For all receivers wit the button ,,Auto Configuration“ — ,,Clear RSSI”

Auto Configuration

Before starting the Auto Configuration, make sure that all Gateways are listed. You may also
want to wait and refresh the meter lists of the gateways until you see all the meters you would
expect.

Once you started the Auto Configuration, all gateways will be scanned again to make sure that
all data is up to date. This may fail silently if at |least one of the gateways does not respond but
no meter configuration will be changed in that case in order to prevent corruption.

If all gateways responded in an expected manner, the algorithm will start whitelisting meters if
there is no device present already having that secondary address. If there are multiple non-
whitelisted meters with the same secondary id, the one with the highest signal strength will be
whitelisted. Additionally, keys will be automatically be applied if aweilable to non-dashing
whitelistable devices.

ou can also reset the known RSSI values. After resetting those, you may have to wait some time
until all meters are rediscovered and listed as being part of the R5SL again.

Cancel Clear RSSI Start

2. For single receivers in the right part of the window in the sheet “Commands” using the

button ,Radio Scan List“ - ,Delete”.

General Status

Refresh Test Connections
Radio Scan List Refresh Delete
Whitelist Refresh Delete

3. For single receivers from the context menu with the right mouse button

Delete RSL"
Search x Filter
Device Man. Ver. RSSI Age RSL WL Key Data
10000001 REL 96
20000002 REL 96
L BEE Refresh
Test Meters
Add Meter
Whitelist
Un-Whitelist
Advanced Refresh RSL
Remowve Refresh Whitelist
- Delete RSL
Delete Whitelist

User Manual RelAirConf- 06/2018 - VERSION 1.1
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Now you have to keep the receivers on reception for a sufficiently long time so that as many of
the stations as possible are included in the Radio Scan List (max. 488 units). The RelAir R2M
constantly expands the RSL in the background when new devices are received. Depending on
the transmission interval of the meters, you should let the receivers scan for at least half an
hour. If the system has transmitters that transmit less frequently, e.g. every 2 hours, you have to
wait longer. After the waiting time please press the button "Refresh Gateways" to read the RSL

of all receivers. Then the RSL of all gateways are displayed:

Search

Device
» 10000001
20000002
78567702
09080701
09080702
00000401
78567701
00000402
80006229
17000284
00000301
00000302
00053928
00041881
» 20000003

Find Gateways

Back

[ RelairConf 1.1.2 - New Project

File Language ¥  Help

Man.
REL
REL
REL
REL
REL
REL
REL
REL
KAM

g

EBEUNBEEBBBERR

REL
REL

88
ggnu

REL

Refresh Gateways

RSSI

-31

-32

-45

-32

42
-18

42

Auto Configuration

Configuration And Diagnostics

p-d
o
[

o000 O00 00000

2

L N N N N N N N LN

KERXKXKXEXXAXXXXX

Filter

Key Data

General

Found During Scan

Meters

RSL Entries

Whitelist Entries

Abort All

Commands

12

12

Here the list of the receiver with the ID = 200000003 is expanded in the view to see the 12
entries of the RSL. These properties are shown in the list for the individual meters

Man.:
Ver.:
RSSI:
Age:
RSL:
WL.:
Key.:

Data:

User Manual RelAirConf- 06/2018 - VERSION 1.1

Manufacturer code from the Wireless M-Bus Protocol

Version from the Wireless M-Bus Protocol
Receive signal strength indicator RSSI (from the time of saving into the RSL)
Age of the last received telegram, in seconds: only for meters in the Whitelist

marked with v, if the meter is in the Radio Scan List

marked with v, if the meter is in the Whitelist, otherwise X
marked with v, if the key is programmed, marked with X : key is missing

empty: no key required

See on page 12
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You can now enter a possibly required key (32 characters consisting of 0 to 9, A to F) per
receiver for each meter to decode the telegram and at the same time add the counter to the
whitelist. All meters that are in the whitelist of the receiver are simulated as wired M-Bus slaves
by the gateway. The whitelist can contain up to 63 meters. You can enter a unique primary
address in the "Pri.Addr." field, which can later be used as an alternative to the secondary
address for reading the meter through the M-Bus. Fields changed during edit are highlighted in
yellow. Write the changes to the gateway with the "Apply" button. a click on the question mark
also gives you an explanation of the corresponding field. A click on the question mark shows
you an explanation of the corresponding field.

File Language &  Help

Search

Device Man.
+ 10000001 REL
' 20000002 REL
78567702 REL
09080701 REL
03080702 REL
00000401 REL
78567701 REL
00000402 REL

80006229 KAM

00000301 REL
00000302 REL
00053928 SEN
00041881 SEN
» 20000003 REL

Back

E RelAirConf 1.1.2 - Mew Project

Configuration And Diagnostics

g

Age

FEEBELUEBEEEER R
+
coooocooocococoo

Find Gateways Refresh Gateways | Auto Configuration

2

L N N NN

x Filter

KEXXEXRXXXXXXX
X

Name

Pri. Addr.

Sec. Addr.

Key

Imp. Key

Whitelist.

Discard

Abort All

Status Commands

80006229

17

0C 35 2C 2080 00 62 29

¢AM, 53, Heat meter (volume measured at flow temperature: inlet)

12345678901234567890123456789012

W AddTo Whitelist

Apply

By right-clicking on the meter, you can also set all the meters of a receiver to the whitelist at the
same time using the context menu:

User Manual RelAirConf- 06/2018 - VERSION 1.1

Device
10000001
78567702
78567701
13345601
00000401
00000402
17000284
00000301
00000302
80006229
09080701
09080702
00000202
00041881
00000201
00053928
00030695
» 20000002
» 20000003

Man. Ver, RSSI
Re nc

g Refresh

E Test Meters

R Add Meter

R Whitelist

Iy

R Un-Whitelist

R Adanced -
K

R Remove
RE=——mor—=z9
REL 80 -38
SEN 104 -42
REL 80 -38
SEN 11 -39
SEN 124 -37
REL 96

REL 96

Age

- --E-N-N-N-N- -

RSL WL Key Data
< X

v x

L4 X

s x

v x

v x x
v x

s X X
v x x
L4 X

v x

L4 X

s x

v x

v x x
v x
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Attention:

Please make absolutely sure that the transmitters are clearly assigned to exactly one receiver,
l.e. only be in the Whitelist for just one RelAir R2M. Otherwise collisions would occur in the
M-Bus network, because each meter of the whitelist is simulated by the gateways as a wired
M-Bus slave. This would prevent a readout of the data in the M-Bus network.

After the whitelisting has been done the gateway waits for the next telegram of the transmitters.
Only after the next reception the data can be read out via the M-Bus. This may require a good
half hour, depending on the transmission frequency of the meters.

E [=][=]r=]
File Language #& Help
Configuration And Diagnostics
Search X Filter
Device Man. Ver. RSSI Age RSL WL Key Data
L = L3 General Commands
w 20000002 REL 9%
78367702 REL BO -53 7 v v v
09080701 REL B0 -36 27 v I I
09080702 REL 80 -38 25 v - - Signal Strength 0 dbm
00000401 REL BO -50 38 v v v
78567701 REL 80 -54 20 v v v
00000402 REL 80 -2 18 .’ v v Last Received Signal 0 seconds ago
80006229 KAM 53 -32 B8 v v X 7
17000284 nw 51 42 7 v s X
00000301 REL B0 0 o v ' I - N
oy v w0 0 0 Py f p In Radio Scan List Slot 18
00053928 SEN 1 0 o v s x (%]
00041881 SEN 104 42 0 v s T -
» 20000003 REL 96 In Whitelist Slot 18
Encrypted
Remote Gateway has no key for the meter but needs one in order to
decrypt messages.
Key Status
& decryption key is required but missing.
Data Status
Find Gateways Refresh Gateways = Auto Configuration Abort All
Back

The "Data" column shows the status of the decoding for each meter. The status of a single
meter can be updated with the context menu "Test Meter". If you right-click on a receiver, you
can update the status of all counters of this receiver. Context menu "Test Meters". The aim
should be to see the check mark v in the column "Data" of all meters that are in the whitelist.

The possible symbols mean:

v Data has been received and decoded correctly.

= So far no data has been received, please wait and use "Test Meter".
Q2 A key is required, but none is set.
Q4 The message could not be decrypted. Please wait or change the key.

After you have made all the settings, you should save the project. Please note that the keys of
the meters cannot be read out of the RelAir R2M devices.

User Manual RelAirConf- 06/2018 - VERSION 1.1 12
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3.2 Automatic Configuration

The steps of key input and manual addition of meters to the whitelists of the individual receivers
in a system with more than one RelAir R2ZM can be mostly automated, in contrast to the

explanations in chapter 3.1.

3.2.2 Import of Keys

You can read the keys from a CSV table and automatically assign them to the meters to avoid
manual key input. Some manufacturers supply files for individual meter keys per delivery, while
other manufacturers use ex-factory so-called global manufacturer-dependent keys, which apply
to all meters supplied, at least for one delivery. The following options are available for importing
keys into RelAirConf for individual lines in the text file:

1) ID, key: individual key for a single ID
Example: 67146207, Ad4ed92b1771435ab46b49b77d73437f

2) Manufacturer code, key: global key for all meters of this manufacturer

Example: ZZZ, Bd4ed92b1771435ab46b49b77d73437f

3) Manufacturer code, ID, Key: individual key for a single ID of the manufacturer XXX
XXX,61010274, 2d4ed92b1771435ab46b49b77d73437f #from here: comment

Instead of a comma, a semicolon can also be used. Spaces are ignored.

& RelairConf 1.1.2 - New Project
File Language & Help

New Channel Ctrl+N

gnostics
New Project
X
Open Project Ctrl+0
= : RsSl | Age | RSL | WL
Save Project Ctrl+5
31 0 v X
. 32 0 v %
Save Project As
-34 0 a *
-45 1] rd x
27 0 v X
Open Key File 44 0 v %
32 0 i x
-42 (1] rd x
Bxit crl+Q|  -18 0 v X
________ — - 29 0 v X
00053528 SEN 11 -58 (1] rd x
00041881 SEN 104 -42 (1] rd b4
+ 20000003 REL %

Find Gateways Refresh Gateways | Auto Configuration

Back

Filter

Name

Pri. Addr.

Sec. Addr.

Key

Imp. Key

Whitelist.

Discard

Abort All

Status

09080701

00 50 48 AC 09 08 07 01

09080701, REL, 80, Other

12345678901234567890123456789012

12345678901234567890123456789012

' AddTo Whitelist

Commands

Apply

User Manual RelAirConf- 06/2018 - VERSION 1.1
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The menu entry "File - Open Key File" opens a dialog for selecting the file. Subsequently, the
respective keys are assigned to the individual meters or all meters of a manufacturer. The key
of a meter is entered into both the "Key" field and the "Imp. Key "(Imported key). The "Key" field
is then highlighted in yellow, as usual, to indicate that the key has been changed and still has to
be written to the gateway with the "Apply" button.

3.2.3 Automatic Whitelisting

The software offers the possibility of automatically assigning the meters to the whitelists in an
M-Bus system with more than one RelAir R2M based on the received signal strength indicator
RSSI. This function relieves the user of the laborious manual assignment and enters each
meter at the gateway with the individually strongest reception. After setting the reception modes
in the gateways and, if necessary, importing the keys (see section 3.2.2), start the automatic
whitelisting by clicking on the "Auto Configuration” button:

B3 RelAirConf 1.1.2 - New Project [s==]

Auto Configuration

Before starting the Auto Configuration, make sure that all Gateways are listed. You may also
want to wait and refresh the meter lists of the gateways until you see all the meters you would
expect.

Once you started the Auto Configuration, all gateways will be scanned again to make sure that
all data is up to date. This may fail sllenﬂylfatleastm‘\edmegatmﬁdosnotmm
nno meter configuration will be changed in that case in order to prevent corruption.

If all gateways responded In an expected manner, the algorithm will start whitelisting meters If
there Is no device present already having that secondary address. If there are muitiple non-

ry a
whitelisted meters with the same secondary Id, the one with the highest signal strength will be
keys will be be applied If avallable to non-clashing

whitelistable devices.

You can also reset the known RSSI values. After resetting those, you may have to wait some time
until all meters are rediscovered and listed as being part of the RSL again.

Cancel Clear RSSI Start

The program now informs you that you should not start this function until all receivers and
meters have been found. If this is the case, it is advisable to first delete the RSSI values (field
strengths) of all meters, because these originate from the time of the first reception of the
respective meter and could therefore be outdated. With the button "Clear RSSI" these data are
deleted and updated with the next reception. This means that you should wait here for a while
depending on the transmission intervals of the meters, e.g. 15 minutes.

After this waiting time you can start the automatic configuration with the button "Start". The data
of the meters are then updated, following the meters are assigned, the imported keys are
entered and each meter is written into the whitelist for exactly one RelAir R2M.

User Manual RelAirConf- 06/2018 - VERSION 1.1 14



Relay.:
SOLUTIONS
O O
O ) S g
| Se—

0

3.3 Description of all menu entries

The main menu of the RelAirConf software offers these three points: File / Language / Help.
Some commonly used submenus have a keyboard shortcut that you can use directly to quickly
execute the command without a mouse. An example is the command "Ctrl-Q" (Exit). The key
"Ctrl" is e.g. on German keyboards also labelled with "Strg".

3.3.1 Menu ,File*

File  Language ¥ Help

New Channel

Mew Project
Open Project
Save Project

Save Project As

Open Key File

Exit

Ctrl+N

Ctrl+0

Ctrl+5

Ctrl+Q

3.3.2 Menu ,Language”

File  lLanguage &  Help

Cont ™" [\

German

Search

New Channel:
Creates a new channel within the active project

New Project:
Creates a new project (collection of channels)

Open Project:
Opens an existing project for editing. The file name of the active
project is displayed in the title bar.

Save Project:
Saves the current project under the existing file name

Save Project As:
Saves the current project under a new file name

Open Key File:
Reads the keys from a CSV file (chapter 3.2.2)

Exit:
Closes the software

Here you can switch the language of the user interface
between German and English. The change is effective
immediately without restarting.

7]
N

r
¥
:. Eli
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3.3.3 Menu ,Help®

File  Language ¥ Help In addition to the PDF manual and the license
information, the "Help" menu also includes the
Channels Toggle Log Ci+L | option to show protocol window and change the
colour design of the user interface.
Create 3 new chanine r &lmmm
License
Open Manual
About
Toggle Log:
E = l=]=]
File Language ¥  Help
Sl Shows or hides a window for logging communication

with the gateways. This can provide information
about possible communication errors in the event of
an error.

Create a new channel from the "File" menu

Exdt

DBG] 15:45:56 deleting GuiMeter

DBG] 15:45:56 deleting MbusMeter

DBG] 15:45:56 deleting GuiMeter

DBG] 15:45:56 deleting MbusMeter

DBG] 15:47:59 deserializing setup

DBG] 15:47:59 deserializing project

DBG] 15:47:59 deserializng mbus

DBG] 15:47:59 new entry: 3918211579383906304
DBG] 15:47:59 deserialing gateway

DBG] 15:47:59 no key found for "2C2080006229"
DBG] 15:47:59 no key found for “C352C2D80006229"
DBG] 15:47:59 deserializing meter

DBG] 15:47:59 no key found for "269717000284"
DBG] 15:47:59 no key found for "733269717000284"
DBG] 15:47:59 deserializing meter

Select Theme:
Here you can choose between various colour designs for the user interface, e.g. to increase the
contrast or to get an inverse representation.

License:
Shows the license information about the software and the used libraries.

Open Manual:
Open this guide in your PDF viewer.

About:
Shows the file paths to the settings file and the automatically generated log file (useful for
troubleshooting). You will additionally see a link to Relay GmbH.
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